
MakeItGrow 2.4

CONTACT INFORMATION:
e-mail: spicerj@ezol.com

web: http://www.ezol.com/~spicerj/index.html
Phone: 1-302-730-8836

Cost: US$20.00 Shareware
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System requirements:   Macintosh with system 8.1 or better, 6 MB of
free RAM, 256 color monitor, 68030CPU or better.

WARNING : This is the last version of MakeItGrow which will support 68K-
based Macs.

Introduction
MakeItGrow is a garden layout package for your Macintosh. It will allow
you to lay out a garden up to 200' x 200', using 96 of the most common
types of vegetables, herbs, and fruits, 100 common flowers, and 44 water
lillies, rushes, and grasses. Each icon is drawn in the correct scale for the
spacing required for the plant. The program also supports line drawing in
eight colors, for garden boundaries, etc, plus a wide selection of fill
patterns and the ability to draw circles, rectangles, and rounded
rectangles, as well as text entry (with support for font, size, and style
selection), in either the vertical or horizontal mode.
The grid is fixed at 6" per square, or 15 cm, allowing for a 200'x200', or
about a 65x65 meter plot.

Limitations
There is no limit to the number of icons (plants) placed upon the plot,
save that of memory and the size of the plot. There is a limit of 200
objects, which can be of any type, I.e. combination of circle/square and
pattern. There is also a limit of 100 text messages, of 80 characters each.
This should be enough to label everything in the plot.
     
Features

• Zone Map
• User database support for three types of data:

[1] New Pests
[2] New Plants
[3] Result notes for each plant tried.

• Note window for each plot
• Importing of plants
• Companion Plant checking
• Zoom (Max 16:1)
• Plaintalk (if installed)
• Select and move items
• Balloon Help
• Printing (both vertical and horizontal)
• Floating Palettes for selection of plants
• Unlimited windows (within available memory)
• Exporting of plots as either PICT or to the clipboard
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• Creation of Estimated Yield based on the number and type of
   plants in the plot
• Drawing of lines, circles, rectangles with fill patterns
• Creation of a text list (export all text entered in the plot)
• Text entry (vertical or horizontal), with support for font, size,
   and styles
• Live palettes - see the plant names by just passing the cursor over
   the buttons
• Rulers displayed in either cm or inches
• Information on companion planting
• Information on pests and diseases
• Backround information on most edible plants
• Layers (8)

Changes from version 2.3 :
Added about 50 flowers.
Added Zone Map.

Changes from version 2.2.4:
Fixed a bug which occurs only under OS 8.1. The program was very

unstable, and would crash randomly.
Added database support.
Rearranged the menus and added the database menu.

Changes from version 2.2.1:
Fixed a bug which would crash the program under 68K when using

Plant Fill - by double-clicking on the garden plot, the program would die.
Added a rectangle to show the size of the current object to be

placed.
Added info for what item was currently selected.

Changes from version 2.2:
Fixed a printing bug.

Changes from version 2.1:
Added layers (up to 8)
Moved Font, Style, and Size menu to the Text Entry dialog (where
they belong)
New Icons (wow!)

Changes from version 2.0:
Addition of notes window
Addition of companion plant checking
Addition of importation of plants

Changes from version 1.9:
Addition of rulers
Addition of companion planting information
Addition of “live” palettes
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Addition of pest and disease information
Addition of backround information on most edible plants
Changes “SpeechLib” to weak link. This means that the program will

run without it. It was fixed before, but reappeared in CodeWarrior 12.
Sigh. Speech is available only on PowerPC systems.

Greatly increased booting speed. It no longer feels like booting Word
6.0!
Changes from version 1.8.3:

Addition of the water lillies, rushes, and grasses.
Addition of sound on/off menu item.

Changes from version 1.8.2:
Fixed a rather annoying bug which cause two apple menus to be

drawn - one below the other. Due to a change in PowerPlant between CW9
and CW11, the menu bar is created automatically, instead of by the
programmer.
Changes from version 1.8.1:

Fixed a bug which caused the program to be unusable on a non-
powermac.
Changes from version 1.8:

Changed “SpeechLib” to weak link. This means that the program will
run without it.
Changes from version 1.7.1:

Changed “Delete” tool button, to “Select” item. An item can now be
selected, moved (except for line segments), and/or deleted using either
the backspace key, or the CLEAR command from the Edit menu.

Zoom out added (Max 16:1)
Changes from version 1.7:

Enhancements to allow faster running on non-powerPC systems.
Changes from version 1.6:

New palette added: Flowers. New menu added: Lines, for drawing
lines in colors. More Miscellaneous items added (fences).
Changes from version 1.5:

Support for drawing rectangles, rounded rectangles, and circles,
with a wide variety of patterns and line weights. Added a redraw
command, and an overview window. New palette added: Tools. More
Miscellaneous items added (more kinds of “garden blocks”).
Changes from version 1.4.1:

Totally rewritten from the ground up in PowerPlant. Multiple window
support added. Now creates a preferences file.
Changes from version 1.4:

New pictures for the fruit trees.
Changes from version 1.3: 

Page Setup...  has been added, to allow printing in landscape mode.
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Many of the menus have been removed, and replaced with floating
palettes. This makes selection of plants easier.
          Balloon help is available.

Installation
Drop the archive on StuffIt Expander and stand back!
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Menu Reference

About.... Menu :  
About Make It Grow!... tells who made the program, etc.

File Menu:
The File menu works in the normal way. If you have changed a plot in any
way, then you will be asked to save the plot before continuing with your
selection.

Edit Menu:
The Edit menu has limited support. Used only for entry/editing of text.
Preferences... Is for entering the user’s registration code, name, the last
usual frost date in the owner’s area, and for specifying units desired for
yield calculations, ie kg or pounds, and style of planting, either normal, or
“French Intensive”. NOTE:  After entering your registration code, you
MUST  exit and re-enter the program.
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Palettes Menu:
Show/hide the specified palette. The six palettes work together, i.e. it is
only possible to choose one item at a time from all six palettes, with the
notable exception of the TOOLS  palette. Each plant has a size
requirement, in most cases, the size of the button corresponds to the size
of the picture, with the notable exception of the fruit trees; the buttons
would have been of enormous size; a 2x2 means the plant requires 2 wide
and 2 long, or 1 ft by 1 ft. There is a “status” window, which shows the
current pick. Note that each palette must always have one button
selected; the active one is the one shown in the status window. The last
palette, “User Defined”, is where any user entered plants will be shown.
There is room for 30 plants.

TOOLS Palette:
The TOOLS palette works differently because of the available choices. The
buttons are in three groups. The first group is the 4 line tools, plus the
text, erase, and group fill tools. Only one of these may be selected at any
one time. The second group are the three shape tools: rectangle, rounded
rectangle, and circle. The third are the patterns. The selections from these
three groups are interdependent. To draw a circle with line weight 2, with
a fill of black, choose first the line weight, then the pattern, and finally
the fill. To fill a selected area with a plant, first choose the plant (or
miscellaneous), and then the AREA FILL tool. Then click-drag to define the
area. It will be filled as close as possible without going outside the area.

9



Layer Menu
You may select from layer 1 through 8. Placement will then occure on the
selected layer, and selection will only be possible on that layer. Layers also
redraw from 1 through 8 - from the bottom up.
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Lines Menu:
Select a color for drawing lines.

DB Menu:
The Database menu controls addition of new plants, new pests, and
personal records. Note that these files are all stored in the Plug-Ins folder.
For earlier users of MakeItGrow upgrading, it will be necessary to
manually create a new “NOTES” folder in the Plug-In folder. Only 10 items
may be entered in each list until the program is registered.
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Edit Pest Info... : Opens a pest info window, in which new pests can
be added. Currently does not support a picture.
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Edit Plant Info... Opens a plant info window, in which new plants
can be added. Currently does not support a
picture.
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Edit Records... Opens an info window, in which detailed
information on a specifict type of plant (ie Bean,
green long golden early) might be kept.

Pests Shows a list of the user-entered pests. Double-click to edit. An entry
may be dragged to another window, such as stickies, etc.
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Plants Shows a list of the user-entered plants. Double-click to edit.
An entry may be dragged to another window, such as stickies, etc.

Records Shows a list of the user-entered records. Double-click to edit.
An entry may be dragged to another window, such as stickies, etc.

Utilities Menu:
Create Seed List:  Creates another file on disk with all text that has been
entered into the plot. If you label your plot with seed selections, for
example BN146 for beans, then this is a direct list of seeds to purchase.
You will be prompted to enter a name for the file, as usual.
Companion Check:  Check the plot for plants which are next to each
other, and dislike each other. The information is shown in the NOTES
window.
Copy Screen to Scrap:  Copies the currently visible portion of the
screen to the scrap for pasting into any graphic program which accepts
PICTs.
Save Plot as PICT:  Saves the plot to the disk as a PICT file. If you have a
very large plot, be warned that the files, although small in themselves, will
require massive amounts of memory. A 6400x6400x256 color PICT file,
for example, will require 40MB of RAM to open!
Show Grid: 
When selected, draws a 6"/15 cm grid on the screen.
Calculate Yield:
Searches the plot, and generates an estimated yield (in either pounds or
kg). You will be prompted for a file name, as usual.
Overview...:
Generates a condensed view of the plot.
Import Plant... : The user may import up to 30 plants into a plug-in file.
See below for more detailed information.
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Zone Map... : The user is shown a zone map of the US and southern
Canada.

Windows Menu:
Shows a list of all open documents, by name.
 
PLACING A PLANT
Select a plant from any of the palettes. Then click on a grid square where
you want the TOP, LEFT corner of the plant to appear.

PLACING A LINE
Select a line size from the tools palette. (default is 2 pt line). Click in the
grid where you want the line to start (the line will start in the TOP, LEFT
corner of the square). Hold the mouse button down, and drag to where
you want the line to end.
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PLACING TEXT
Select either Horizontal or Vertical text placement from the misc. palette.
The cursor will change to an I-beam. Click in the box where you want the
text to start. A pop-up dialog will appear, allowing entry of text (80 char
max). The Edit menu is supported for this. The text will be aligned with
the TOP, LEFT corner of the box. Type your message. Click OK. Click in
another spot to enter another message, if desired. 

PLACING AN OBJECT
Select the line weight, pattern, and shape desired. Click and drag until
desired size is achieved.

DELETING A PLANT
Select the Arrow from the TOOLS  palette. Click anywhere in the item. Use
the DELETE  key or the CLEAR command to delete the item.

DELETING AN OBJECT
Select the Arrow from the TOOLS  palette. Click anywhere in the item. Use
the DELETE  key or the CLEAR command to delete the item.

DELETING A TEXT MESSAGE
Select the Arrow from the TOOLS  palette. Click anywhere in the item. Use
the DELETE  key or the CLEAR command to delete the item.

DELETING A LINE
Click in the TOP, LEFT square. Delete same as above.
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MOVING AN ITEM
Use the “Select” (Arrow) tool from the TOOLS  palette. Click and hold
until the item starts to move. Then, drag to where you want the item to
go.

HOW TO ZOOM
To zoom, use the zoom in and zoom out buttons located and the lower
left corner of the window.

GETTING PLANT INFO
There are two ways to see the backround information on a plant. The first
is to double-click a plant on a palette. If information is available, it will be
shown. The second is to Option-Click  a plant on the plot using the
selection tool. Same results.

HOW TO SEE THE PESTS INFO
After showing a particular plant info, click on the PESTS button to show a
dialog with a list of pests and pictures if available.
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IMPORTING A PLANT
Select Import Plant  from the Utilities  menu. A dialog box will be
shown, with three active parts. The first two are for the normal (ie, the
picture you want plotted), and the alternate (button pressed) picture. The
third is an edit field, to enter the name of the plant. The pictures must be
pasted in from the clipboard. Select which pane you want the plant pasted
into, then select Paste from the Edit  menu (or Control-V ). Drag&Drop is
not supported yet.
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Notes Window
At the top right corner of a plot window, just above the scroll bar, is a N.
Clicking here will show/hide a notes window, which is saved with each
plot.

UPDATES
Updates are always free. Your code will always work on future versions of
the program. Please register, it means the program will continue to be
supported and updated.
I will gladly install any particular plant that you want, provided that you
send me a picture, any info you have; and allow me to include it in all
future releases (ie, I'm not gonna do it just for you, but for everybody!)

NOTE:  The about box is live. Clicking on a hotspot will run Netscape (if
available) and either take you to the specified web site, or e-mail.

Picture Plug-in
Registered users can download the free companion datafile, MIG-PICTS,
which contains color digitized pictures of most of the vegetables, herbs,
and fruits displayed in this program. Each plant is shown at 2 and 6 weeks
of growth, along with some background information about each. Warning
- this file is BIG! 3.3 MB! Only registered users can see the pictures in this
datafile (which must be placed in the plug-in’s folder), if the program is
unregistered, they will be ignored.
Available at: <http://www.islandnet.com/~spicerj/dragon.html>
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